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About this guide
This user guide contains the information you need when installing and configuring 
the server management board.

How this guide is organized
This guide contains the following parts:

• Chapter 1: Product introduction
This chapter offers the PIKE 1078 SAS RAID card features and the new 
technologies it supports.

• Chapter 2: RAID configuration
This chapter provides instructions on setting up, creating, and configuring 
RAID sets using the available utilities.

• Chapter 3: Driver installation
This chapter provides instructions for installing the RAID drivers on different 
operating systems.

Where to find more information
Refer to the following sources for additional information and for product and 
software updates.

1. ASUS websites
The ASUS website provides updated information on ASUS hardware and 
software products. Refer to the ASUS contact information.

2. Optional documentation
Your product package may include optional documentation, such as warranty 
flyers, that may have been added by your dealer. These documents are not 
part of the standard package.
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Typography
Bold text Indicates a menu or an item to select.

Italics Used to emphasize a word or a phrase.

<Key>    Keys enclosed in the less-than and greater-than sign means  
 that you must press the enclosed key. 

  Example: <Enter> means that you must press the Enter or  
  Return key.

<Key1+Key2+Key3> If you must press two or more keys simultaneously, the key  
 names are linked with a plus sign (+).  
 
 Example: <Ctrl+Alt+D>

Command Means that you must type the command exactly as shown,  
 then supply the required item or value enclosed in  
 brackets.  
   
 Example: At the DOS prompt, type the command line:  
 format a:

  DANGER/WARNING: Information to prevent injury to yourself  
 when trying to complete a task. 

  CAUTION: Information to prevent damage to the components  
 when trying to complete a task. 

  NOTE: Tips and additional information to help you complete a  
 task.

  IMPORTANT: Instructions that you MUST follow to complete a  
 task.

Conventions used in this guide
To make sure that you perform certain tasks properly, take note of the following 
symbols used throughout this manual.
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PIKE 1078 specifications summary

* Install the i-Button for PIKE 1078 to work properly.
** The exact OS support would base on the OS support list of the motherboard.
*** Specifications are subject to change without notice.

Controller LSISAS1078
Interface ASUS PIKE interface
Ports 8 ports
Support device SAS and SATA II devices
Data transfer rate SATA II and SAS 3 Gb/s per PHY
RAID level RAID 0 / RAID 1 / RAID 10 / RAID 5 / RAID 50 / RAID 6 /  

 RAID 60*
OS support** Windows® Server 2003 / Server 2008 / XP / Vista 

Red Hat®  Enterprise Linux 3 / 4 / 5 
SUSE Linux Enterprise Server 8 / 9 / 10 
LSI MegaRAID Storage Manager (MSM) for Windows® /  
 Linux operating systems

Form factor 6.44 in x 1.57 in (1U compatible)



1Chapter 1: Product 
introduction

This chapter offers the PIKE 1078 
SAS RAID card features and the new 
technologies it supports.
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1.1 Welcome!
Thank you for buying an ASUS® PIKE 1078 SAS RAID card! 

The ASUS PIKE 1078 allows you to create RAID 0, RAID 1, RAID 10, RAID 5, 
RAID 50, RAID 6, and RAID 60 set(s) from SAS hard disk drives connected to the 
SAS connectors on the motherboard.

Before you start installing the RAID card, check the items in your package with the 
list below.

If any of the above items is damaged or missing, contact your retailer.

1.2 Package contents
Check your package for the following items.

• ASUS PIKE 1078 SAS RAID card
• MEGARAID KEY i-BUTTON supporting 8 physical devices
• 4 port SATA to SAS cable x 2
• SGPIO cable x 2
• Support CD
• User guide
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1.3 Card layout
The images below show the major components of the RAID card.

1.4 System requirements
Before you install the PIKE 1078 SAS RAID card, check if the system meets the 
following requirements:

• Workstation or server motherboard with a PIKE RAID card slot
• SAS or SATA hard disk drives
• Supporting operating system:

Windows® and Linux operating systems (refer to website for details)

• Other requirement:
- Appropriate thermal solution
- Certified power supply module

1. ASUS PIKE interface-1: PCI-E x8
2. ASUS PIKE interface-2: 8-port SAS signal with SGPIO interface*
3. SAS RAID card status LED (lights up and blinks to indicate that the card is 

working normally)

*  The SGPIO interface is used for visibility into drive activity, failure and rebuild 
status, so that users could build high-performatnce and reliable storage 
systems. Refer to the motherboard manual for detailed information about 
using the SGPIO connectors on the motherboard.

1

3

122

1

3

122

(Outer heatsink removed, for 1U server)
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1.5 Card installation
Follow the below instructions to install the RAID card on your motherboard.

Please do remember to install i-button and set IBTN RAID setting jumper 
(usually named ITBN_SEL1) to [PIKE RAID5] after installing PIKE card. Refer 
to the motherboard’s manual for details.

For 2U, 5U, or pedestal server
To install ASUS PIKE 1078 SAS RAID card on a 2U, 5U, or pedestal server
1. Locate the PIKE RAID card slot on 

the motherboard.

2. Align the golden fingers of the RAID 
card with the PIKE RAID card slot.

3. Insert the RAID card into the PIKE RAID card slot. Make sure the card is 
completely inserted into the card slot, and the heatsink latch is completely 
hooked to the edge of the card slot.
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5. Connect the SAS hard disk drives 
to the SAS connectors on the 
motherboard.

4. Secure the heatsink to the nearest 
screw hole on the motherboard.

DO NOT overtighten the screw, 
or the motherboard component 
can be damaged. 

To uninstall ASUS PIKE 1078 SAS RAID card from a 2U, 5U, or pedestal server

1. Disconnect all SAS hard disk 
drives from the motherboard.

2. Remove the screw that secures the 
RAID card to the motherboard.

3. Release the heatsink latch from 
the card slot with a finger, and then 
remove the RAID card from the 
slot.
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For 1U server
You have to remove the outer heatsink of ASUS PIKE 1078 SAS RAID card to 
install the card in a 1U server.

To install ASUS PIKE 1078 SAS RAID card on a 1U server

1. Remove the two screws that secure 
the heatsink bracket on the back of 
the SAS RAID card.

Heatsink bracket

3. Locate the PIKE RAID card slot on 
the motherboard.

2. Remove the two screws that 
secure the outer heatsink on the 
front of the SAS RAID card.

DO NOT remove the inner 
heatsink from the SAS RAID 
card.
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4. Align the golden fingers of the 
RAID card with the PIKE RAID 
card slot.

5. Insert the RAID card into the PIKE 
RAID card slot. Make sure the card 
is completely inserted into the card 
slot.

6. Connect the SAS hard disk drives 
to the SAS connectors on the 
motherboard.
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2Chapter 2: RAID 
configuration

This chapter provides instructions on setting 
up, creating, and configuring RAID sets using 
the available utilities.
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2.1 Setting up RAID
The RAID card supports RAID 0, RAID 1, RAID 10, RAID 5, RAID 50, RAID 6, and 
RAID 60 set(s).

2.1.1 RAID definitions
RAID 0 (Data striping) optimizes two identical hard disk drives to read and write 
data in parallel, interleaved stacks. Two hard disks perform the same work as a 
single drive but at a sustained data transfer rate, double that of a single disk alone, 
thus improving data access and storage. Use of at least two new identical hard 
disk drives is required for this setup.

RAID 1 (Data mirroring) copies and maintains an identical image of data from one 
drive to a second drive. If one drive fails, the disk array management software 
directs all applications to the surviving drive as it contains a complete copy of 
the data in the other drive. This RAID configuration provides data protection and 
increases fault tolerance to the entire system. Use two new drives or use an 
existing drive and a new drive for this setup. The new drive must be of the same 
size or larger than the existing drive.

RAID 10 is a striped configuration with RAID 1 segments whose segments are 
RAID 1 arrays. This configuration has the same fault tolerance as RAID 1, and 
has the same overhead for fault-tolerance as mirroring alone. RAID 10 achieves 
high input/output rates by striping RAID 1 segments. In  some instances, a RAID 
10 configuration can sustain multiple simultaneous drive failure. A minimum of four 
hard disk drives is required for this setup.

RAID 5 stripes both data and parity information across three or more hard 
disk drives. Among the advantages of RAID 5 configuration include better 
HDD performance, fault tolerance, and higher storage capacity. The RAID 
5 configuration is best suited for transaction processing, relational database 
applications, enterprise resource planning, and other business systems. Use a 
minimum of three identical hard disk drives for this setup.

RAID 50 is a combination of RAID 0 and RAID 5. It uses distributed parity and disk 
striping and works best with data that requires high reliability, high request rates, 
high data transfers, and medium-to-large capacity.

Having RAID 0 and RAID 5 virtual disks in the same physical array is not 
recommended. If a drive in the physical array has to be rebuilt, the RAID 0 
virtual disk will cause a failure during the rebuild.

RAID 6 stripes dual parity to provide fault tolerance from two drive failures; array 
continues to operate with up to two failed drives. This makes larger RAID groups 
more practical, especially for high availability systems. With dual parity, RAID 6 
gives time to rebuild the array without the data being volatile while the failed drive 
is being recovered.
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If you want to boot the system from a hard disk drive included in a created RAID 
set, copy first the RAID driver from the support CD to a floppy disk before you 
install an operating system to the selected hard disk drive. 

2.1.2 Installing hard disk drives
The RAID card supports SAS for RAID set configuration. For optimal performance, 
install identical drives of the same model and capacity when creating a disk array.

To install SAS hard disks for RAID configuration:

1. Install the SAS hard disks into the drive bays following the instructions in the 
system user guide.

2. Connect the SAS port connectors to the SAS drives.

RAID 60 is a combination of RAID 0 and RAID 6. It uses distributed parity, with two 
independent parity blocks per stripe in each RAID set, and disk striping. A RAID 
60 virtual disk can survive the loss of two disks in each of the RAID 6 sets without 
losing data. It works best with data that requires high reliability, high request rates, 
high data transfers, and medium-to-large capacity.
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2.2 LSI WebBIOS Configuration Utility
The LSI WebBIOS Configuration Utility (CU) is an integrated RAID solution that 
allows you to create RAID 0, 1, 10, 5, 50, 6, and 60 set(s) from SAS hard disk 
drives supported by the LSI SAS 1078 controller.

You can also use the WebBIOS CU to do the following tasks:

 • Create physical arrays and virtual disks for storage configurations
 • Delete virtual disks
 • Migrate a storage configuration to a different RAID level
 • Detect configuration mismatches
 • Import a foreign configuration
 • Display adapter, virtual disk, and physical drive properties.
 • Scan devices connected to the controller
 • Initialize virtual disks
 • Check configurations for data consistency

• PIKE 1078 does not support the Battery Backup Unit (BBU) function.

• You may use disks of different sizes; however, the size of the smallest disk 
determines the “logical” size of each member disk.

• DO NOT combine Serial ATA and SAS disk drives in one volume.

• The RAID setup screens shown in this section are for reference only and 
may not exactly match the items on your screen due to the controller 
version difference.

LSI MegaRAID SAS-MFI BIOS
Version NT16 (Build Nov 20, 2007)
Copyright(C) 2007 LSI Corporation
HA -0 (Bus 2 Dev 0) MegaRAID SAS PCI Express(TM) ROMB
FW package: 8.0.1-0029

Battery Status: Not present
 SLOT  ID    LUN  VENDOR     PRODUCT                  REVISION   CAPACITY
 ----  --    ---  ------     -------                  --------   --------
 6                LSI        MegaRAID SAS PCI Express(1.12.122-0393256MB
 6     0     0    ATA        Hitachi HDS72161         AB3A         157066MB
 6     2     0    ATA        Hitachi HDS72161         AB3A         157066MB
 6     3     0    ATA        Hitachi HDS72161         AB3A         157066MB
 6     4     0    ATA        Hitachi HDS72107         A70M         715404MB
 6     5     0    ATA        Hitachi HDS72107         A70M         715404MB
 6     6     0    ATA        Hitachi HDS72107         A70M         715404MB
0 Virtual Drive(s) found on the host adapter.
0 Virtual Drive(s) handled by BIOS
Press <Ctrl><H> for WebBIOS or press <Ctrl><Y> for Preboot CLI

2.2.1 Starting the WebBIOS CU
Follow these steps to start the WebBIOS CU and access the main screen.

1. Turn on the system after installing all SAS hard disk drives.
2. During POST, press <Ctrl+H> when the following text appears on the screen:
 The Adapter Selection screen appears.

Press <Ctrl+Y> for Preboot CLI: this option is for advanced debug only!
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2.2.2 WebBIOS CU main screen options

This is the Logical View screen, which displays in the lower right panel all virtual 
disks (virtual drives) that are configured on this controller. It also shows in the 
upper right panel the physical drives that are connected to the controller. To toggle 
between the physical view and logical view of the storage devices connected to the 
controller, click Physical View or Logical View in the menu on the left. When the 
Physical View screen is displayed, the lower right panel displays the arrays that 
are configured on this controller.

3. If the system has multiple SAS adapters, select an adapter.
4. Click Start to continue. The main WebBIOS CU screen appears.

WebBIOS CU Toolbar Icons

Icon Description

Click this icon to return to the main screen from any other WebBIOS CU screen.

Click this icon to return to the previous screen that you were viewing.

Click this icon to exit the WebBIOS CU program.

Click this icon to display the Adapter Selection screen. If the computer system 
has multiple adapters, you use this screen to view the devices connected to a 
different controller.

Click this icon to turn off the sound on the onboard controller alarm.

Click this icon to display information about the WebBIOS CU version, browser 
version, and HTML interface engine.
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Here is a description of the options listed on the left of the main WebBIOS CU 
screen:

• Adapter Properties: Select this to view the properties of the currently selected 
SAS adapter.

• Scan Devices: Select this to have the WebBIOS CU re-scan the physical and 
virtual disks for any changes in the drive status or the physical configuration. 
The WebBIOS CU displays the results of the scan in the physical and virtual 
disk descriptions.

• Virtual Disks: Select this to view the Virtual Disks screen, where you can 
change and view virtual disk properties, delete virtual disks, initialize disks, and 
perform other tasks. 

• Physical Drives: Select this to view the Physical Drives screen, where you 
can view physical drive properties, create hot spares, and perform other tasks. 

• Configuration Wizard: Select this to start the Configuration Wizard and create 
a new storage configuration, clear a configuration, or add a configuration. 

• Adapter Selection: Select this to view the Adapter Selection screen, where 
you can select a different SAS adapter. You can then view information about 
the adapter and the devices connected to it, or create a new configuration on 
the adapter.

• Physical View/Logical View: Select this to toggle between the Physical View 
and Logical View screens. 

• Events: Select this to view system events in the Event Information screen. 
• Exit: Select this to exit the WebBIOS CU and continue with system boot.
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2.2.3 Creating a Storage Configuration
This section explains how to use the WebBIOS CU Configuration Wizard to 
configure RAID arrays and virtual disks. 

Selecting the Configuration with the Configuration Wizard
Follow these steps to start the Configuration Wizard, and select a configuration 
option and mode:

1.  Click Configuration Wizard on 
the WebBIOS main screen. The 
first Configuration Wizard screen 
appears, as shown in the right 
figure.

2. Select a configuration option.

If you choose the first or second option, all existing data in the configuration will 
be deleted. Make a backup of any data that you want to keep before choosing 
these options.

 • Clear Configuration: Clears the existing configuration.
 • New Configuration: Clears the existing configuration and lets you  

 create a new configuration.
 • Add Configuration: Retains the existing storage configuration and adds  

 new drives to it (this does not cause any data loss).

3. Click Next. A dialog box warns that you will lose data if you select Clear 
Configuration or New Configuration.

4. On the next screen, select a configuration mode:
 • Custom Configuration: Allows you to control all attributes of the new  

 storage configuration.
 • Auto Configuration with Redundancy: Automatically creates an  

 optimal RAID 1 or RAID 5 configuration, providing data redundancy. We  
 recommends that you select this option.

 • Auto Configuration without Redundancy: Automatically creates a  
 non-redundant RAID 0 configuration.

5. Click Next to continue. 
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Using Auto Configuration
Follow these instructions to create a configuration with auto configuration, either 
with or without redundancy:

1. When WebBIOS displays the proposed new configuration, review the 
information on the screen, and click Accept to accept it. (Or click Back to go 
back and change the configuration.)

 • RAID 0: If you selected Auto Configuration without Redundancy,  
 WebBIOS creates a RAID 0 configuration.

 • RAID 1: If you selected Auto Configuration with Redundancy,  
 WebBIOS creates a RAID 1 configuration if only two disk drives are  
 available.

 • RAID 5: If you selected Auto Configuration with Redundancy,  
 WebBIOS creates a RAID 5 configuration if three or more disk drives are  
 available.

2. Click Yes when you are prompted to save the configuration.
3. Click Yes when you are prompted to initialize the new virtual disk(s).
 WebBIOS CU begins a background initialization of the virtual disks.

Using Custom Configuration: RAID 0
RAID 0 provides disk striping across all drives in the RAID array. RAID 0 does not 
provide any data redundancy but does offer the best performance of any RAID 
level. RAID 0 is ideal for applications that require high bandwidth but do not require 
fault tolerance. RAID 0 also denotes an independent or single drive. 

RAID level 0 is not fault-tolerant. If a drive in a RAID 0 array fails, the whole 
virtual disk (all physical drives associated with the virtual disk) fails.

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. You use this screen to select physical drives to create disk groups 
(arrays).

1. Hold <Ctrl> while selecting two or 
more ready drives in the Physical 
Drives window on the left until you 
have selected all desired physical 
drives for the disk group.

2. Click Accept DG to move the 
drives to a proposed disk group 
configuration in the Disk Groups 
window on the right, as shown in 
the right figure. 

 If you need to undo the changes, click the Back button.
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3. When you have finished selecting 
physical disks for the disk groups, 
click Next.

 The span definition screen appears 
Select one of the available disk 
groups, and then click Add to 
Span.

4. When finish, click Next. The Virtual 
Disk Definition screen appears, 
as shown in the right figure. You 
use this screen to select the RAID level, strip size, read policy, and other 
attributes for the new virtual disks.

5. Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
• RAID Level: The drop-down menu lists the possible RAID levels for the 

virtual disk. Select RAID 0.
• Strip Size: The strip size specifies the size of the segment written to 

each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes.

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access. This is the default.
 ◊ Read Only: Allow read-only access.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive:
 ◊ Normal: This disables the read ahead capability. This is the default.
 ◊ Ahead: This enables read ahead capability, which allows the controller 

to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.

 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).
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• Write Policy: Specify the write policy for this virtual drive: 
 ◊ WBack: In Writeback mode the controller sends a data transfer 

completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.

 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.

 ◊ Direct: In direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default.

 ◊ Cached: In cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy:
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status:
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller.

• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 0 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group.

6. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.

7. Click Next when you are finished defining virtual disks. The configuration 
preview screen appears, as shown in the following figure.
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8. Check the information in the configuration preview.
9. If the virtual disk configuration is acceptable, click Accept to save the 

configuration. Otherwise, click Cancel to end the operation and return to the 
WebBIOS main menu, or click Back to return to the previous screens and 
change the configuration.

10. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.

Using Custom Configuration: RAID 1
In RAID 1, the RAID controller duplicates all data from one drive to a second 
drive. RAID 1 provides complete data redundancy, but at the cost of doubling the 
required data storage capacity. It is appropriate for small databases or any other 
environment that requires fault tolerance but small capacity.

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. You use this screen to select physical drives to create disk groups 
(arrays).

1. Hold <Ctrl> while selecting two 
ready physical drives in the Physical 
Drives window on the left.

2.  Click Accept DG to move the 
drives to a proposed disk group 
configuration in the Disk Groups 
window on the right, as shown in 
the right figure. 

 If you need to undo the changes, 
click the Back button.
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3. When you have finished selecting 
physical disks for the disk groups, 
click Next.

 The span definition screen appears 
Select one of the available disk 
groups, and then click Add to 
Span.

4. When finish, click Next. The Virtual 
Disk Definition screen appears, 
as shown in the right figure. You 
use this screen to select the RAID level, strip size, read policy, and other 
attributes for the new virtual disks.

5.  Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
•  RAID Level: The drop-down menu lists the possible RAID levels for the 

virtual disk. Select RAID 1.
• Strip Size: The strip size specifies the size of the segment written to 

each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes.

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access. This is the default.
 ◊ Read Only: Allow read-only access.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive: 
 ◊ Normal: This disables the read ahead capability. This is the default.
 ◊ Ahead: This enables read ahead capability, which allows the controller 

to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.

 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).

• Write Policy: Specify the write policy for this virtual drive:
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 ◊ WBack: In Writeback mode the controller sends a data transfer 
completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.

 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.

 ◊ Direct: In Direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default.

 ◊ Cached: In Cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy:
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status:
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller.

• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 1 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group.

6. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.
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7. Click Next when you are finished 
defining virtual disks. The 
configuration preview screen 
appears, as shown in the right 
figure.

8. Check the information in the 
configuration preview.

9. If the virtual disk configuration is 
acceptable, click Accept to save 
the configuration. Otherwise, click 
Cancel to end the operation and return to the WebBIOS main menu, or click 
Back to return to the previous screens and change the configuration.

10. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.

Using Custom Configuration: RAID 5
RAID 5 uses disk striping at the block level and parity. In RAID 5, the parity 
information is written to all drives. It is best suited for networks that perform a 
lot of small input/output (I/O) transactions simultaneously. RAID 5 provides data 
redundancy, high read rates, and good performance in most environments. It also 
provides redundancy with lowest loss of capacity.

RAID 5 provides high data throughput. RAID 5 is useful for transaction processing 
applications because each drive can read and write independently. If a drive fails, 
the RAID controller uses the parity drive to recreate all missing information. You 
can use RAID 5 for office automation and online customer service that require 
fault tolerance. In addition, RAID 5 is good for any application that has high read 
request rates but low write request rates.

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. You use this screen to select physical drives to create disk groups 
(arrays).

1. Hold <Ctrl> while you select at least 
three ready physical drives in the 
Physical Drives window on the left.

2. Click Accept DG to move the 
drives to a proposed disk group 
configuration in the Disk Groups 
window on the right, as shown in 
the right figure.

 If you need to undo the changes, 
click the Back button.
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5. Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
• RAID Level: The drop-down menu lists the possible RAID levels for the 

virtual disk. Select RAID 5.
• Strip Size: The strip size specifies the size of the segment written to 

each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes.

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access. This is the default.
 ◊ Read Only: Allow read-only access.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive: 
 ◊ Normal: This disables the read ahead capability. This is the default.
 ◊ Ahead: This enables read ahead capability, which allows the controller 

to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.

 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).

• Write Policy: Specify the write policy for this virtual drive:

3. When you have finished selecting physical disks for disk groups, click Next. 
The span definition screen appears Select one of the available disk groups, 
and then click Add to Span.

4. When finish, click Next. The Virtual 
Disk Definition screen appears, as 
shown in the following figure. You 
use this screen to select the RAID 
level, strip size, read policy, and 
other attributes for the new virtual 
disks.
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 ◊ WBack: In Writeback mode the controller sends a data transfer 
completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.

 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.

 ◊ Direct: In Direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default.

 ◊ Cached: In Cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy:
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status: 
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller.

• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 5 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group.

6. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.

7. Click Next when you are finished defining virtual disks.
 The configuration preview screen appears, as shown in the following figure.
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8. Check the information in the configuration preview.
9. If the virtual disk configuration is acceptable, click Accept to save the 

configuration. Otherwise, click Cancel to end the operation and return to the 
WebBIOS main menu, or click Back to return to the previous screens and 
change the configuration.

10. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.

Using Custom Configuration: RAID 6
RAID 6 is similar to RAID 5 (disk striping and distributed parity), except that instead 
of one parity block per stripe, there are two. With two independent parity blocks, 
RAID 6 can survive the loss of two disks in a virtual disk without losing data. Use 
RAID 6 for data that requires a very high level of protection from loss.

RAID 6 is best suited for networks that perform a lot of small input/output (I/O) 
transactions simultaneously. It provides data redundancy, high read rates, and 
good performance in most environments.

In the case of a failure of one drive or two drives in a virtual disk, the RAID 
controller uses the parity blocks to recreate all the missing information. If two 
drives in a RAID 6 virtual disk fail, two drive rebuilds are required, one for each 
drive. These rebuilds do not occur at the same time. The controller rebuilds one 
failed drive, and then the other failed drive.

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. You use this screen to select physical drives to create disk groups 
(arrays).

1.  Hold <Ctrl> while selecting at least three ready physical drives in the Physical 
Drives window on the left. 
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2.  Click Accept DG to move the 
drives to a proposed disk group 
configuration in the Disk Groups 
window on the right, as shown in 
the right figure.

 If you need to undo the changes, 
click the Back button.

3. When you have finished selecting 
physical disks for disk groups, click 
Next. The span definition screen 
appears Select one of the available 
disk groups, and then click Add to 
Span.

4. When finish, click Next. The Virtual 
Disk Definition screen appears, as 
shown in the following figure. You 
use this screen to select the RAID 
level, strip size, read policy, and other attributes for the new virtual disks.

5. Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
• RAID Level: The drop-down menu lists the possible RAID levels for the 

virtual disk. Select RAID 6.
• Strip Size: The strip size specifies the size of the segment written to 

each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes.

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access. This is the default.
 ◊ Read Only: Allow read-only access.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive:
 ◊ Normal: This disables the read ahead capability. This is the default.
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 ◊ Ahead: This enables read ahead capability, which allows the controller 
to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.

 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).

• Write Policy: Specify the write policy for this virtual drive: 
 ◊ WBack: In Writeback mode the controller sends a data transfer 

completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.

 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.

 ◊ Direct: In Direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default.

 ◊ Cached: In Cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy: 
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status: 
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller. 
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• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 6 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group.

6. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.

7. Click Next when you are finished 
defining virtual disks.

 The configuration preview screen 
appears, as shown in the right 
figure.

8. Check the information in the 
configuration preview.

9. If the virtual disk configuration is 
acceptable, click Accept to save 
the configuration. Otherwise, click 
Cancel to end the operation and return to the WebBIOS main menu, or click 
Back to return to the previous screens and change the configuration.

10. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.

Using Custom Configuration: RAID 10
RAID 10, a combination of RAID 1 and RAID 0, has mirrored drives. It breaks up 
data into smaller blocks, then stripes the blocks of data to each RAID 1 disk group. 
Each RAID 1 disk group then duplicates its data to its other drive. The size of each 
block is determined by the strip size parameter. RAID 10 can sustain one drive 
failure in each array while maintaining data integrity.

RAID 10 provides both high data transfer rates and complete data redundancy. 
It works best for data storage that must have 100 percent redundancy of RAID 1 
(mirrored arrays) and that also needs the enhanced I/O performance of RAID 0 
(striped arrays); it works well for medium-sized databases or any environment that 
requires a higher degree of fault tolerance and moderate to medium capacity.

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. 

You use the Disk Group Definition screen to select physical drives to create disk 
groups (arrays).

1. Hold <Ctrl> while selecting two ready physical drives in the Physical Drives 
window on the left.
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2. Click Accept DG to move the drives to a proposed two-drive disk group 
configuration in the Disk Groups window on the right.

 If you need to undo the changes, click the Back button.
3. Hold <Ctrl> while selecting two more ready physical drives in the Physical 

Drives window to create a second two-drive disk group.
4. Click Accept DG to move the drives 

to a second two-drive disk group 
configuration in the Disk Groups 
window, as shown in the right figure. 

 If you need to undo the changes, 
click the Back button.

5. When you have finished selecting 
physical disks for the disk groups, 
click Next.

 The span definition screen appears. 
You should add both disk groups 
you’ve created in the previous step 
to Span section. Select the disk 
group in Array With Free Space 
section and then click Add to Span.

6. When finish, click Next. The Virtual 
Disk Definition screen appears, as shown in the right figure. 

 You use this screen to select the RAID level, strip size, read policy, and other 
attributes for the new virtual disks. 

7. Hold <Ctrl> while selecting 2 two-drive disk groups in the Configuration 
window on the right.

The WebBIOS Configuration Utility displays the maximum available capacity 
while creating the RAID 10 disk group. In version 1.03 of the utility, the 
maximum size of the RAID 10 disk group is the sum total of the two RAID 1 disk 
groups. In version 1.1, the maximum size is the size of the smaller disk group 
multiplied by two.

8. Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
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• RAID Level: The drop-down menu lists the possible RAID levels for the 
virtual disk. Select RAID 10.

• Strip Size: The strip size specifies the size of the segment written to 
each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes.

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access.
 ◊ Read Only: Allow read-only access. This is the default.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive:
 ◊ Normal: This disables the read ahead capability. This is the default.
 ◊ Ahead: This enables read ahead capability, which allows the controller 

to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.

 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).

• Write Policy: Specify the write policy for this virtual drive: 
 ◊ WBack: In Writeback mode the controller sends a data transfer 

completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.

 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.
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 ◊ Direct: In Direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default.

 ◊ Cached: In Cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy:
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status:
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller.

• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 10 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group. 

9. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.

10. When you are finished defining 
virtual disks, click Next. The 
configuration preview screen 
appears, as shown in the right 
figure.

11. Check the information in the 
configuration preview.

12. If the virtual disk configuration is 
acceptable, click Accept to save 
the configuration. Otherwise, click 
Cancel to end the operation and return to the WebBIOS main menu, or click 
Back to return to the previous screens and change the configuration.

13. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.
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Using Custom Configuration: RAID 50
RAID 50 provides the features of both RAID 0 and RAID 5. RAID 50 uses both 
distributed parity and disk striping across multiple arrays. It provides high data 
throughput, data redundancy, and very good performance. It is best implemented 
on two RAID 5 disk arrays with data striped across both disk arrays. Though 
multiple drive failures can be tolerated, only one drive failure can be tolerated in 
each RAID 5 level array. 

RAID 50 is appropriate when used with data that requires high reliability, high 
request rates, high data transfer, and medium to large capacity.

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. You use this screen to select physical drives to create disk groups 
(arrays).

1. Hold <Ctrl> while selecting at least three ready physical drives in the Physical 
Drives window on the left.

2. Click Accept DG to move the drives to a proposed disk group configuration 
in the Disk Groups window on the right.

 If you need to undo the changes, click the Back button.
3. Hold <Ctrl> while selecting at least three more ready physical drives in the 

Physical Drives window to create a second disk group.
4. Click Accept DG to move the 

drives to a proposed disk group 
configuration in the Disk Groups 
window on the right, as shown in 
the right figure.

 If you need to undo the changes, 
click the Back button.

5. When you have finished selecting 
physical disks for the disk groups, 
click Next.

 The span definition screen appears. 
You should add both disk groups 
you’ve created in the previous step 
to Span section. Select the disk 
group in Array With Free Space 
section and then click Add to Span.

6. When finish, click Next. The Virtual 
Disk Definition screen appears, as 
shown in the right figure.
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 You use this screen to select the RAID level, strip size, read policy, and other 
attributes for the new virtual disk(s). 

7. Hold <Ctrl> while selecting 2 three-drive disk groups in the Configuration 
window on the right.

8. Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
• RAID Level: The drop-down menu lists the possible RAID levels for the 

virtual disk. Select RAID 50.
• Strip Size: The strip size specifies the size of the segment written to 

each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes. 

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access.
 ◊ Read Only: Allow read-only access. This is the default.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive:
 ◊ Normal: This disables the read ahead capability. This is the default.
 ◊ Ahead: This enables read ahead capability, which allows the controller 

to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.

 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).

• Write Policy: Specify the write policy for this virtual drive:
 ◊ WBack: In Writeback mode the controller sends a data transfer 

completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.
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 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.

 ◊ Direct: In Direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default. 

 ◊ Cached: In Cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy:
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status:
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller.

• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 50 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group. 

9. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.

10. Click Next when you are finished 
defining virtual disks. The 
configuration preview screen 
appears, as shown in the right 
figure.

11. Check the information in the 
configuration preview.

12. If the virtual disk configuration is 
acceptable, click Accept to save 
the configuration. Otherwise, click 
Cancel to end the operation and return to the WebBIOS main menu, or click 
Back to return to the previous screens and change the configuration.
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Using Custom Configuration: RAID 60
RAID 60 provides the features of both RAID 0 and RAID 6, and includes both 
parity and disk striping across multiple arrays. RAID 6 supports two independent 
parity blocks per stripe. A RAID 60 virtual disk can survive the loss of two disks in 
each of the RAID 6 sets without losing data. RAID 60 is best implemented on two 
RAID 6 disk arrays with data striped across both disk arrays. Use RAID 60 for data 
that requires a very high level of protection from loss.

RAID 60 can support up to eight spans and tolerate up to 16 drive failures, though 
less than total disk drive capacity is available. Two drive failures can be tolerated in 
each RAID 6 level array. 

RAID 60 is appropriate when used with data that requires high reliability, high 
request rates, high data transfer, and medium to large capacity. 

When you select Custom Configuration and click Next, the Disk Group Definition 
screen appears. You use this screen to select physical drives to create disk groups 
(arrays).

1. Hold <Ctrl> while selecting at least three ready physical drives in the Physical 
Drives window on the left.

2. Click Accept DG to move the drives to a proposed disk group configuration 
in the Disk Groups window on the right. 

 If you need to undo the changes, click the Back button.
3. Hold <Ctrl> while selecting at least three more ready physical drives in the 

Physical Drives window to create a second disk group.
4. Click Accept DG to move the 

drives to a proposed disk group 
configuration in the Disk Groups 
window on the right, as shown in 
the right figure.

 If you need to undo the changes, 
click the Back button.

13. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.
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5. When you have finished selecting 
physical disks for the disk groups, 
click Next.

 The span definition screen appears. 
You should add both disk groups 
you’ve created in the previous step 
to Span section. Select the disk 
group in Array With Free Space 
section and then click Add to Span.

6. When finish, click Next. The Virtual 
Disk Definition screen appears, as shown in the right figure. You use this 
screen to select the RAID level, strip size, read policy, and other attributes for 
the new virtual disk(s).

7. Hold <Ctrl> while selecting 2 three-drive disk groups in the Configuration 
window on the right.

8. Change the virtual disk options from the defaults listed on the screen as 
needed.

 Here are brief explanations of the virtual disk options:
• RAID Level: The drop-down menu lists the possible RAID levels for the 

virtual disk. Select RAID 60.
• Strip Size: The strip size specifies the size of the segment written to 

each disk in a RAID configuration. You can set the strip size to 8, 16, 32, 
64, 128, 256, 512 or 1024 Kbytes. A larger strip size produces higher 
read performance. If your computer regularly performs random read 
requests, choose a smaller strip size. The default is 64 Kbytes.

• Access Policy: Select the type of data access that is allowed for this 
virtual disk:

 ◊ RW: Allow read/write access.
 ◊ Read Only: Allow read-only access. This is the default.
 ◊ Blocked: Do not allow access.
• Read Policy: Specify the read policy for this virtual drive:
 ◊ Normal: This disables the read ahead capability. This is the default.
 ◊ Ahead: This enables read ahead capability, which allows the controller 

to read sequentially ahead of requested data and to store the additional 
data in cache memory, anticipating that the data will be needed soon. 
This speeds up reads for sequential data, but there is little improvement 
when accessing random data.
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 ◊ Adaptive: When Adaptive read ahead is selected, the controller 
begins using read ahead if the two most recent disk accesses occurred 
in sequential sectors. If the read requests are random, the controller 
reverts to Normal (no read ahead).

• Write Policy: Specify the write policy for this virtual drive:
 ◊ WBack: In Writeback mode the controller sends a data transfer 

completion signal to the host when the controller cache has received 
all the data in a transaction. This setting is recommended in Standard 
mode.

 ◊ WThru: In Writethrough mode the controller sends a data transfer 
completion signal to the host when the disk subsystem has received all 
the data in a transaction. This is the default.

 ◊ Wrthru for BAD BBU: Select WBack for Write Policy and unselect this 
item if you want the controller to use Writeback mode but the controller 
has no BBU or the BBU is bad. If you choose this option, the controller 
firmware automatically switches to Writethrough mode if it detects a bad 
or missing BBU.

• IO Policy: The IO Policy applies to reads on a specific virtual disk. It 
does not affect the read ahead cache.

 ◊ Direct: In Direct I/O mode, reads are not buffered in cache memory. 
Data is transferred to the cache and the host concurrently. If the same 
data block is read again, it comes from cache memory. This is the 
default. 

 ◊ Cached: In Cached I/O mode, all reads are buffered in cache memory.
• Disk Cache Policy: Specify the disk cache policy:
 ◊ Enable: Enable the disk cache.
 ◊ Disable: Disable the disk cache. This is the default.
 ◊ NoChange: Leave the current disk cache policy unchanged.
• Disable BGI: Specify the background initialization status:
 ◊ No: Leave background initialization enabled. This means that a 

new configuration can be initialized in the background while you use 
WebBIOS to do other configuration tasks. This is the default.

 ◊ Yes: Select Yes if you do not want to allow background initializations 
for configurations on this controller.

• Select Size: Specify the size of the virtual disk in megabytes. Normally, 
this would be the full size for RAID 60 shown in the Configuration Panel 
on the right. You may specify a smaller size if you want to create other 
virtual disks on the same disk group.



2-30 Chapter 2: RAID configuration

9. Click Accept to accept the changes to the virtual disk definition, or click Back 
to return to the previous settings.

10. Click Next when you are finished 
defining virtual disks.

 The configuration preview screen 
appears, as shown in the right 
figure.

11. Check the information in the 
configuration preview.

12. If the virtual disk configuration is 
acceptable, click Accept to save 
the configuration. Otherwise, click 
Cancel to end the operation and return to the WebBIOS main menu, or click 
Back to return to the previous screens and change the configuration.

13. If you accept the configuration, click Yes at the prompt to save the 
configuration.

 The WebBIOS main menu appears.
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2.2.4 Viewing and Changing Device Properties
This section explains how you can use the WebBIOS CU to view and change the 
properties for adapters, virtual disks, physical drives, and BBUs.

WebBIOS allows you to view information for the LSI SAS adapter. To view the 
properties for the adapter, click Adapter Properties on the main WebBIOS screen. 
There are two Adapter Properties screens. The following figure shows the first 
screen.

The information on this screen is read-only and cannot be modified directly. Most of 
this information is self-explanatory. The screen lists the number of virtual disks that 
are already defined on this adapter, plus the number of physical disks connected to 
the adapter.

If a background initialization is in progress, you can click Background Init 
Progress to determine its state of completion. Click Next to view the second 
Adapter Properties screen, as shown in the following figure.

The following table describes the entries/options listed on the second Adapter 
Properties screen. We recommend that you leave these options at their default 
settings to achieve the best performance, unless you have a specific reason for 
changing them.
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Adapter Properties Menu Options
Option Description
Battery Backup This entry indicates whether the selected controller has a BBU. If 

present, you can click Present to view information about the BBU.
Set Factory 
Defaults

Use this option to load the default MegaRAID® WebBIOS CU settings. 
The default is [No].

Cluster Mode Use this option to enable or disable Cluster mode. The default is 
[Disabled]. A cluster is a grouping of independent servers that can 
access the same data storage and provide services to a common set 
of clients. When Cluster mode is disabled, the system operates in 
Standard mode.

Rebuild Rate Use this option to select the rebuild rate for physical drives connected 
to the selected adapter. The default is 30 percent. The rebuild rate is 
the percentage of system resources dedicated to rebuilding a failed 
drive. The higher the number, the more system resources devoted to a 
rebuild.

BGI Rate Use this option to select the amount of system resources dedicated 
to background initialization of virtual disks connected to the selected 
adapter. The default is 30 percent.

CC Rate Use this option to select the amount of system resources dedicated to 
consistency checks of virtual disks connected to the selected adapter. 
The default is 30 percent.

Reconstruction 
Rate

Use this option to select the amount of system resources dedicated to 
reconstruction of physical disks connected to the selected adapter. The 
default is 30 percent.

Adapter BIOS Use this option to enable or disable the BIOS for the selected adapter. 
The default is [Enabled]. If the boot device is on the selected controller, 
the BIOS must be enabled; otherwise, the BIOS should be disabled or 
it might not be possible to use a boot device elsewhere.

Coercion Mode Disk coercion is a tool for forcing physical disks of varying capacities 
to the same size so they can be used in an array. The coercion mode 
options are [None], [128MB-way], and [1GB-way]. The default is 
[None].

The number you choose depends on how much the 
drives from various vendors vary in their actual size. We 
recommend that you use the 1GB coercion mode option.
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Adapter Properties Menu Options (Cont.)
Option Description
PDF Interval This option determines how frequently the controller polls for physical 

drives reporting a Predictive Drive Failure (S.M.A.R.T. error). The 
default is 300 seconds (5 minutes).

Alarm Control Select this option to enable, disable, or silence the onboard alarm tone 
generator on the controller. The default is [Disabled].

Patrol Read 
Rate

Use this option to select the rate for patrol reads for physical drives 
connected to the selected adapter. The default is 30 percent. The patrol 
read rate is the percentage of system resources dedicated to running a 
patrol read. See Section 3.5, “Patrol Read-Related Adapter Properties” 
for additional information about patrol read.

Cache Flush 
Interval

Use this option to control the interval (in seconds) at which the contents 
of the onboard data cache are flushed. The default is 4 seconds.

Spinup Drive 
Count

Use this option to control the number of drives that spin up 
simultaneously. The default is 2 drives.

Spinup Delay Use this option to control the interval (in seconds) between spinup of 
physical disks connected to this controller. The delay prevents a drain 
on the system’s power supply that would occur if all disks spun up at 
the same time. The default is 12 seconds.

StopOnError Enable this option if you want the boot process to stop when the 
controller BIOS encounters an error during boot-up. The default is 
[Disabled].

Additional Adapter Properties Menu Options 
(For WebBIOS Version 1.1-33d-Rel)

Option Description
Stop CC On 
Error

Use this option to control if consistency check will stop when error 
found. The default is No.

Schedule CC “Supported” will be displayed if the controller supports consistency 
check schedule. Click the link to set consistency check schedule.

Maintain PD 
Fail History

Use this option to control if controller will maintain physical disk fail 
history.

If you make changes to the options on this screen, click Submit to register them. If 
you change your mind, click Reset to return the options to their default values.
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Viewing and Changing Virtual Disk Properties
Access the Virtual Disk screen by selecting a virtual disk (virtual disk) from the 
virtual disk list on the WebBIOS CU main screen and clicking Virtual Disk. The 
following figure shows the Virtual Disk screen.

The Properties panel of this screen displays the virtual disk’s RAID level, state, 
size, and strip size.

The Policies panel lists the virtual disk policies that were defined when the storage 
configuration was created. To change any of these policies, make a selection from 
the drop-down menu and click Change.

The Operations panel lists operations that can be performed on the virtual disk. 
To perform an operation, select it and click Go. Then choose from the following 
options:

• Select Del to delete this virtual disk. 
• Select Locate to make the LEDs flash on the physical drives used by this 

virtual disk. This works only if the drives are installed in a disk enclosure that 
supports SAFTE.

• Select Fast or Slow to initialize this virtual disk. A fast initialization quickly 
writes zeroes to the first and last 10 Mbyte regions of the new virtual disk 
and then completes the initialization in the background. A slow initialization 
is not complete until the entire virtual disk has been initialized with zeroes. It 
is seldom necessary to use this option, because the virtual disk was already 
initialized when you created it.

Before you run an initialization, back up any data on the virtual disk that you 
want to save. All data on the virtual disk is lost when you initialize it.

In WebBIOS Version 1.1-33d-Rel, the initialization items will be Fast Init and 
Slow Init.
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• Select CC to run a consistency check on this virtual disk.  
In the right panel of the Virtual Disk screen you can change the virtual disk 
configuration by adding or removing a physical drive or by changing the RAID 
level.

Before you change a virtual disk configuration, back up any data on the virtual 
disk that you want to save.

For more information about changing RAID level, please refer to Migrating the 
RAID Level of a Virtual Disk in section 2.2.6 Managing Configurations.

To remove a physical drive from a virtual disk, select the drive in the small panel 
beneath the Remove physical drive option. Then select Remove physical drive 
and click Go at the bottom of the panel.

Viewing Physical Drive Properties
The Physical Drive screen displays 
the properties of a selected physical 
drive and also enables you to perform 
operations on the physical drive. The right 
figure shows the Physical Drive window.

The physical drive properties are view-
only and are self-explanatory. Note 
that the properties include the state of 
the disk’s physical drive. The operations listed at the bottom of the screen vary 
depending on the state of the drive. After you select an operation, click Go to start 
the operation.

• Select MakeDriveOffline if you want to force the physical drive offline.

If you force offline a good physical drive that is part of a redundant array with 
a hot spare, the drive will rebuild to the hot spare drive. The drive you forced 
offline will go into the Unconfigured and Bad state. Access the BIOS utility to set 
the drive to the Unconfigured and Good state.

• Select Locate to make the LED flash on the physical drive. This works only if 
the drive is installed in a disk enclosure.

• If the selected physical drive is not already part of a disk group, you have the 
option of making it a Global hot spare or a Dedicated hot spare.

 WebBIOS displays the global hot spare as Global and the dedicated hot 
spare as Ded.

• A Prepare for removal option may also appear.
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2.2.5 Viewing System Event Information
The SAS controller firmware monitors the activity and performance of all storage 
configurations and devices in the system. When an event occurs (such as the 
creation of a new virtual disk or the removal of a physical drive) an event message 
is generated and is stored in the controller NVRAM. You can use the WebBIOS CU 
to view these event messages. To do this, click Events on the main WebBIOS CU 
screen. The Event Information screen appears, as shown in the following figure.

The right side of the screen is blank until you select an event to view. The First 
Sequence and Last Sequence fields in the upper left of the screen show you how 
many event entries are currently stored.

To view event information, follow these steps:

1. Select an Event Locale from the menu. For example, select Enclosure to 
view events relating to the disk enclosure.

2. Select an Event Class: [Informational], [Warning], [Critical], [Fatal], or [Dead].
3. Enter a Start Sequence number, between the First Sequence and Last 

Sequence numbers. The higher the number, the more recent the event.
4. Enter the Number of events of this type that you want to view, and click Go.
 The first event in the sequence appears in the right panel.
5. Click Next or Prev to page forward or backward through the sequence of 

events.
6. If you want, select different event criteria in the left panel, and click Go again 

to view a different sequence of events.
 Each event entry includes a timestamp and a description to help you 

determine when the event occurred and what it was.
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2.2.6 Managing Configurations
This section includes information about maintaining and managing storage 
configurations.

Running a Consistency Check
You should periodically run a consistency check on fault-tolerant virtual disks. A 
consistency check verifies that the redundancy data is correct and available for 
RAID 1, RAID 5, RAID 6, RAID 10, RAID 50, and RAID 60 arrays. To do this, follow 
these steps:

1. On the main WebBIOS CU screen, select a virtual disk.
2. When the Virtual Disk screen appears, select CC in the lower left panel, and 

click Go. 
 The consistency check begins.

If the WebBIOS CU finds a difference between the data and the parity value on the 
redundant array, it assumes that the data is accurate and automatically corrects 
the parity value. Be sure to back up the data before running a consistency check if 
you think the consistency data may be corrupted.

Deleting a Virtual Disk
You can delete any virtual disk on the controller if you want to reuse that space for 
a new virtual disk. The WebBIOS CU provides a list of configurable arrays where 
there is a space to configure. If multiple virtual disks are defined on a single array, 
you can delete a virtual disk without deleting the whole array.

To delete a virtual disk, follow these steps:

Back up any data that you want to keep before you delete the virtual disk.

1. On the main WebBIOS CU screen, select a virtual disk.
2. When the Virtual Disk screen appears, select Del in the lower left panel, and 

click Go.
3. When the message appears, confirm that you want to delete the virtual disk.

Importing or Clearing a Foreign Configuration
A foreign configuration is a storage configuration that already exists on a 
replacement set of physical disks that you install in a computer system. In addition, 
if one or more physical disks are removed from a configuration, by a cable pull or 
physical disk removal, for example, the configuration on those disks is considered 
a foreign configuration by the RAID controller.
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The WebBIOS CU allows you to import the foreign configuration to the RAID 
controller, or to clear the configuration so you can create a new configuration using 
these physical disks.

If WebBIOS CU detects a foreign configuration, the screen appears, as shown in 
the following figure.

The GUID (Global Unique Identifier) entries on the drop-down list are OEM names 
and will vary from one installation to another.

Click ClearForeignCfg if you want to clear the configuration and reuse the 
physical disks.

Click GUIDPreview if you want to preview the foreign configuration. The screen, 
as shown in the following figure, appears.

The right panel shows the virtual disk properties of the foreign configuration. In this 
example, there is a RAID 1 virtual disk with 1,000 Mbytes. The left panel shows the 
physical disks that comprise the foreign configuration.

Click Import to import this foreign configuration and use it on this controller.

Click Cancel to clear the configuration and reuse the physical disks for another 
virtual disk.
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Foreign Configurations in Cable Pull and Disk Removal Scenarios
If one or more physical disks are removed from a configuration, by a cable 
pull or physical disk removal, for example, the configuration on those disks is 
considered a foreign configuration by the RAID controller.

Use the Foreign Configuration Preview screen to import or clear the 
foreign configuration in each case.

The following scenarios can occur with cable pulls or physical disk removals.

If you want to import the foreign configuration in any of the following scenarios, 
you should have all the drives in the enclosure before you perform the import 
operation.

1. Scenario #1: If all of the physical disks in a configuration are removed 
and re-inserted, the controller considers the drives to have foreign 
configurations.

 Import or clear the foreign configuration. If you select Import, automatic 
rebuilds will occur in redundant virtual disks.

Start a consistency check immediately after the rebuild is complete to ensure 
data integrity for the virtual disks.

2. Scenario #2: If some of the physical disks in a configuration are removed 
and re-inserted, the controller considers the drives to have foreign 
configurations. Import or clear the foreign configuration. If you select 
Import, automatic rebuilds will occur in redundant virtual disks.

Start a consistency check immediately after the rebuild is complete to ensure 
data integrity for the virtual disks. 

3. Scenario #3: If all the physical disks in a virtual disk are removed, but 
at different times, and re-inserted, the controller considers the drives to 
have foreign configurations. 

 Import or clear the foreign configuration. If you select Import, all drives 
that were pulled before the virtual disk became offline will be imported 
and then automatically rebuilt. Automatic rebuilds will occur in redundant 
virtual disks.

4. If the physical disks in a non-redundant virtual disk are removed, the 
controller considers the drives to have foreign configurations. Import or 
clear the foreign configuration. No rebuilds will occur after the import 
operation because there is no redundant data to rebuild the drives with.
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Migrating the RAID Level of a Virtual Disk
As the amount of data and the number of disk drives in your system increase, 
you can use RAID-level migration to change a virtual disk from one RAID level to 
another. You do not have to power down or reboot the system. When you migrate 
a virtual disk, you can keep the same number of drives, or you can add drives. You 
can use the WebBIOS CU to migrate the RAID level of an existing virtual disk.

While you can apply RAID-level migration at any time, LSI that recommends you 
do so when there are no reboots. Many operating systems issues I/O operations 
serially (one at a time) during boot. With a RAID-level migration running, a boot 
can often take more than 15 minutes.

Migrations are allowed for the following RAID levels:

• RAID 0 to RAID 1
• RAID 0 to RAID 5
• RAID 1 to RAID 5
• RAID 1 to RAID 6

The following table lists the number of additional disk drives required when you 
change the RAID level of a virtual disk.

Additional disk Drives Required for RAID-Level Migration
From RAID Level to RAID 
Level

Original Number of Disk 
Drives in Array

Additional Disk Drives 
Required

RAID 0 to RAID 1 RAID 0: 1 drive 1
RAID 0 to RAID 5 RAID 0: 1 drive 2
RAID 1 to RAID 5 RAID 1: 2 drives 1
RAID 1 to RAID 6 RAID 1: 2 drives 1

Follow these steps to migrate the RAID level:

Back up any data that you want to keep before you change the RAID level of 
the virtual disk.

1. On the main WebBIOS CU screen, select a virtual disk.
2. When the Virtual Disk screen appears, select Migration only (and skip to 

step 5) or Migration with addition in the right panel.
3. If you selected Migration with addition, select one or more physical disks 

from the small window in the lower right of the screen.
4. Select a new RAID level from the drop-down menu on the right. The available 

RAID levels are limited, based on the current RAID level of the virtual disk 
plus the number of physical disks available.
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5. When you have made your selections, click Go at the bottom of the right 
panel.

6. When the message appears, confirm that you want to migrate the RAID level 
of the virtual disk.

A reconstruction operation begins on the virtual disk. You must wait until the 
reconstruction is completed before performing any other tasks in the WebBIOS 
CU.
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2.3 MegaRAID Storage Manager
MegaRAID Storage Manager software enables you to configure, monitor, and 
maintain storage configurations on LSI SAS controllers. The MegaRAID Storage 
Manager graphical user interface (GUI) makes it easy for you to create and 
manage storage configurations.

2.3.1 Hardware and Software Requirements
The hardware requirements for MegaRAID Storage Manager software are as 
follows:

• PC-compatible computer with an IA-32 (32-bit) Intel Architecture processor or 
an EM64T (64-bit) processor and at least 128 Mbytes of system memory (256 
Mbytes recommended)

• Disk drive with at least 50 Mbytes available free space 
The supported operating systems for the MegaRAID Storage Manager software 
are as follows:

• Microsoft Windows 2000, Microsoft Windows Server 2003, Microsoft Windows 
XP, and Microsoft Windows Vista

• Red Hat Linux 3.0, 4.0, or 5.0
• SUSE SLES 9 and 10, with latest updates and service packs
Refer to your server documentation and to the operating system documentation for 
more information on hardware and operating system requirements.

2.3.2 Installing MegaRAID Storage Manager Sofware on  
 Microsoft Windows OS
Follow these steps if you need to install MegaRAID Storage Manager software on 
a system running Microsoft Windows OS:

1. Insert the MegaRAID Storage Manager software installation CD in the CD-
ROM drive.

 If necessary, find and double-click the setup.exe file to start the installation 
program.

2. When the Welcome screen appears, click Next.
 If MegaRAID Storage Manager software is already installed on this system, 

the Program Maintenance screen appears. Read the screen text and select 
Modify, Repair, or Remove.

3. When the next screen appears, read and accept the user license, and click 
Next.

 The Customer Information screen appears, as shown in the following figure.
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4. Enter your user name and organization name. In the bottom part of the 
screen, select an installation option:
– If you select All users, any user with administrative privileges can use 

this version of MegaRAID Storage Manager software to view or change 
storage configurations.

– If you select Only for current user, the MegaRAID Storage Manager 
shortcuts and associated icons will be available only to the user with this 
user name.

5. Click Next to continue.
6. On the next screen, accept the default Destination Folder, or click Change to 

select a different destination folder. Click Next to continue.
 The Setup Type screen appears, as shown in the following figure.
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7. Select one of the Setup options. The options are fully explained in the screen 
text.
– Normally, you would select Complete if you are installing MegaRAID 

Storage Manager software on a server.
– Select Custom Installation if you want to select individual program 

components.
8. Click Next to continue.
 If you selected Custom Installation as your setup option, the second Setup 

Type screen appears, as shown in the following figure.
 If you select Complete as your setup option, the Installation Wizard is ready 

to install MSM. To begin installation, click on Install on the next screen that 
appears.

9.  Select one of the custom setup options. The options are fully explained in the 
screen text.
– Select Client if you are installing MegaRAID Storage Manager software 

on a PC that will be used to view and configure servers over a network. 
To begin installation, click on Install on the next screen that appears.

– Select Server to install only those components required for remote 
server management. To begin installation, click on Install on the next 
screen that appears.

– Select StandAlone if you will use MegaRAID Storage Manager 
software to create and manage storage configurations on a standalone 
workstation. To begin installation, click on Install on the next screen that 
appears.

– Select Custom if you want to specify individual program features to 
install.

 If you select Custom, a window listing the installation features appears, as 
shown in the following figure. Select the features you want on this screen.
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10. Click Next to proceed.
11. Click Install to install the program.
12. When the final Configuration Wizard screen appears, click Finish.
 If you select Client installation for a PC used to monitor servers, and if there 

are no available servers with a registered framework on the local subnet 
(that is, servers with a complete installation of MegaRAID Storage Manager 
software), the server screen will appear, as shown in the following figure. The 
server screen will not list any servers. You can use this screen to manage 
systems remotely.
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2.3.3 Installing MegaRAID Storage Manager Sofware for  
 Linux
Follow these steps if you need to install MegaRAID Storage Manager software on 
a system running Red Hat Linux or SUSE Linux:

1. Copy the MSM_linux_installer...tar.gz file to a temporary folder.
2. Untar the MSM_linux_installer...tar.gz file using the following command:
 tar -zxvf MSM_linux_installer...tar.gz
 A new disk directory is created.
3. Go to the new disk directory.
4. In the disk directory, find and read the readme.txt file.
5. To start the installation, enter the following command:
 csh install.sh -a

If you select Client installation for a PC used to monitor servers, and if there are no 
available servers with a registered framework on the local subnet (that is, servers 
with a complete installation of MegaRAID Storage Manager software), the server 
screen appears. The server screen does not list any servers. You can use this 
screen to manage systems remotely.
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2.3.4 Linux Error Messages
The following messages may appear while you are installing MegaRAID Storage 
Manager software on a Linux system:

• More than one copy of MegaRAID Storage Manager software has been 
installed.

 This message indicates that the user has installed more than one copy of 
MegaRAID Storage Manager software. (This can be done by using the rpm-
force command to install the rpm file directly, which is not recommended, 
instead of using the install.sh file.) In such cases, the user must uninstall all the 
rpm files manually before installing MegaRAID Storage Manager software with 
the procedure listed previously.

• The version is already installed.
 This message indicates that the version of MegaRAID Storage Manager 

software you are trying to install is already installed on the system.
• The installed version is newer.
 This message indicates that a version of MegaRAID Storage Manager 

software is already installed on the system, and it is a newer version than the 
version you are trying to install.

• Exiting installation.
 This is the message that appears when the installation is complete.
• RPM installation failed.
 This message indicates that the installation failed for some reason. Additional 

message text explains the cause of the failure.
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2.3.5 Starting MegaRAID Storage Manager Software
Follow these steps to start MegaRAID Storage Manager software and view the 
main window:

1. Start the program using the method required for your operating system 
environment:
– To start MegaRAID Storage Manager software on a Microsoft Windows 

system, select Start > Programs > MegaRAID Storage Manager > 
StartupUI, or double-click the MegaRAID Storage Manager shortcut on 
the desktop.

If a warning appears stating that Windows Firewall has blocked some features 
of the program, click Unblock to allow MegaRAID Storage Manager software to 
start. (The Windows Firewall sometimes blocks the operation of programs that 
use Java.)

– To start MegaRAID Storage Manager software on a Red Hat Linux 
system, select Applications > System Tools > MegaRAID Storage 
Manager StartupUI.

– To start MegaRAID Storage Manager software on a SUSE SLES 9 
system, select Start > System > More Programs > MegaRAID Storage 
Manager.

2. When the program starts, the Select Server window appears, as shown in the 
following figure.

 If the circle in the server icon is yellow instead of green, it means that the 
server is running in a degraded state—for example, because a disk drive 
used in a virtual disk has failed. If the circle is red, the storage configuration 
in the server has failed.
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To access servers on a different subnet, type in the box at the bottom of the 
screen the IP address of a server in the desired subnet where the MegaRAID 
Storage Manager software is running, and click Update. If you check the 
Connect to remote server at: IP address box, you can also access a 
standalone (remote) installation of MegaRAID Storage Manager software, if it 
has a network connection.

3. Double-click the icon of the server that you want to access. The Server Login 
window appears, as shown in the following figure.

4. Select an access mode from the drop-down menu.
– Select Full Access if you need to both view the current configuration 

and change the configuration.
– Select View Only if you need to only view and monitor the configuration.

5. Enter your user name and password, and click Login.

If the computer is networked, this is the login to the computer itself, not the 
network login.

 You must enter the root/administrator user name and password to use Full 
Access mode. If your user name and password are correct for the Login 
mode you have chosen, the main MegaRAID Storage Manager window 
appears.
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2.3.6 MegaRAID Storage Manager Window
This section describes the MegaRAID Storage Manager window, which is shown in 
the following figure.

Physical/Logical View Panel
The left panel of the MegaRAID Storage Manager window displays either the 
Physical view or the Logical view of the system and the devices in it, depending on 
which tab is selected.

• The Physical view shows the hierarchy of physical devices in the system. 
At the top of the hierarchy is the system itself. One or more controllers are 
installed in the system. The controller label identifies the MegaRAID controller, 
such as the ASUS PIKE 1078 controller, so that you can easily differentiate 
between multiple controllers. Each controller has one or more ports. Disk 
drives and other devices are attached to the ports.

• The Logical view shows the hierarchy of controllers, virtual disks, and disk 
groups that are defined on the system. (Physical drives also appear in the 
Logical view, so you can see which physical drives are used by each virtual 
disk.)

The following icons in the left panel represent the controllers, disk drives, and other 
devices:

• System 

• Controller 

• Port 
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• Array 

• Virtual disk 
• Physical drive 

• Enclosure 
• Battery backup unit (BBU) 

A red circle to the right of an icon indicates that the device has failed. For example, 
this icon indicates that a physical drive has failed: .

A yellow circle to the right of an icon indicates that a device is running in a 
degraded state. For example, this icon indicates that a virtual disk is running in a 

degraded state because a disk drive has failed: .

Properties/Operations/Graphical View Panel
The right panel of the MegaRAID Storage Manager window has either two or three 
tabs, depending on what kind of device is selected in the left panel.

• The Properties tab displays information about the selected device. For 
example, if a controller icon is selected in the left panel, the Properties tab lists 
information such as the controller name, NVRAM size, and device port count. 

• The Operations tab lists the operations that can be performed on the device 
that is selected in the left panel. For example, the following figure shows the 
options that are available when a controller is selected. These include enabling 
or silencing the alarm and running a Patrol Read. Some types of devices, such 
as arrays and ports, do not have operations associated with them. 
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• The Graphical View tab can be selected in the right panel if a physical drive, 
virtual disk, or disk enclosure is selected in the left panel. In graphical view, the 
device’s storage capacity is color coded according to the legend shown on the 
screen. For example, on a physical drive configured space is blue, available 
space is white, and reserved space is red, as shown in the following figure.

Event Log Panel
The lower part of the MegaRAID Storage Manager window displays the system 
event log entries. New event log entries appear during the session. Each entry has 
an ID, a timestamp and date, an error level indicating the severity of the event, and 
a brief description of the event.

Menu Bar
Here are brief descriptions of the main selections on the MegaRAID Storage 
Manager menu bar.

File Menu
The File menu has an Exit option for exiting from the MegaRAID Storage 
Manager software. It also has a Rescan option for updating the display in 
the MegaRAID Storage Manager window. (Rescan is seldom required; the 
display normally updates automatically.)
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Operations Menu
The Operations menu is available when a controller, physical drive, or virtual 
disk is selected in the MegaRAID Storage Manager window. The Operations 
menu options vary depending on what type of device is selected in the left 
panel of the MegaRAID Storage Manager window. For example, the Scan 
for Foreign Config option is available only when a controller is selected. The 
options also vary depending on the current state of the selected device. For 
example, if you select an offline physical drive, the Make Drive Online option 
appears in the Operations menu.

You can also view the Operations selections on the main window on the 
Operations tab in the right panel. If an operation requires user inputs before 
it can be executed, it appears in the Operations tab but not in the Operations 
menu. A device-specific Operations menu pops up if you right-click a device 
icon in the left panel.

Configuration options are also available. This is where you access the 
Configuration Wizard and other configuration-related commands. To access 
the other configuration commands, select Operations > Configuration.

Group Operations Menu
The Group Operations menu options include Check Consistency, Initialize, 
and Show Progress.

Tools Menu
On the Tools menu you can select Configure > Monitor Configurator to 
access the Event Configuration Notification screen, which you can use to set 
the alert delivery rules, event severity levels, exceptions, and email settings.

Log Menu
The Log menu includes options for saving and clearing the message log. 

Help Menu
On the Help menu you can select Help > Help to view the MegaRAID 
Storage Manager online help file. You can select Help > About to view 
version information for the MegaRAID Storage Manager software.

• When you use the MegaRAID Storage Manager online help, you may see a 
warning message that Internet Explorer has restricted the file from showing 
active content. If this warning appears, click on the active content warning 
bar and enable the active content.

• If you are using the Linux operating system, you must install Firefox® or 
Mozilla® for the MegaRAID Storage Manager online help to display.
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3Chapter 3: Driver 
installation

This chapter provides instructions for 
installing the RAID drivers on different 
operating systems.
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3.1 RAID driver installation
After creating the RAID sets for your server system, you are now ready to install 
an operating system to the independent hard disk drive or bootable array. This part 
provides instructions on how to install or update the RAID card drivers.

The RAID card driver might be included in the Linux OS installation CD, and 
could be loaded automatically during OS installation. However, we recommend 
using the RAID driver packaged in the RAID card support CD for better 
reliability.

Loading FreeDOS FAT KERNEL GO!
Press any key to boot from CDROM...

3.1.1 Creating a RAID driver disk
You may have to use another system to create the RAID driver disk from the 
RAID card support CD or from the Internet.

A floppy disk with the RAID driver is required when installing Windows® or Linux 
operating system on a hard disk drive that is included in a RAID set. You can 
create a RAID driver disk in DOS (using the Makedisk application in the support 
CD).

To create a RAID driver disk in DOS environment:

1. Place the RAID card support CD in the optical drive.
2. Restart the computer, then enter the BIOS Setup.
3. Select the optical drive as the first boot priority to boot from the support CD. 

Save your changes, then exit the BIOS Setup.
4. Restart the computer.
5. Press any key when prompted to boot from CD.

6. The Makedisk menu appears. Select LSI 1078 SAS Driver, and press 
<Enter> to enter the sub-menu.

Create Driver Diskette Menu
PIKE 1078 SAS Driver
FreeDOS command prompt
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8. Place a blank, high-density floppy disk to the floppy disk drive.
9. Press <Enter>.
10. Follow screen instructions to create the driver disk.

7. Use the arrow keys to select the type of RAID driver disk you want to create.

LSI 1078 SAS card Driver
Windows 2000 Server SP4
Windows XP 32 bit
Windows XP 64 bit
Windows Server 2003 32 bit
Windows Server 2003 64 bit
Windows Vista 32 bit
Windows Vista 64 bit
Windows Server 2008 32 bit
Windows Server 2008 64 bit
RHEL 3 UP4 32/64 bit
RHEL 3 UP5/UP6 32/64 bit
RHEL 3 UP7/UP8 32/64 bit
RHEL 4 32/64 bit
RHEL 4 UP5 32/64 bit
RHEL 5 32/64 bit
SLES 9 SP1 32/64 bit
SLES 9 SP2 32/64 bit
SLES 9 SP3 32/64 bit
SLES 10 32/64 bit
Back
Exit
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3.1.2 Windows® OS

During Windows® OS installation
To install the RAID card driver when installing Windows® OS:

1. Boot the computer using the Windows® OS installation CD. The Window® 
Setup starts.

2. Press <F6> when the message “Press F6 if you need to install a third party 
SCSI or RAID driver...” appears at the bottom of the screen.

3. The next screen appears. Press <S> to specify an additional device.

Windows Setup

S=Specify Additional Device   ENTER=Continue   F3=Exit

Setup could not determine the type of one or more mass storage devices
installed in your system, or you have chosen to manually specify an adapter.
Currently, Setup will load support for the following mass storage 
devices(s):

   <none>

* To specify additional SCSI adapters, CD-ROM drives, or special
  disk controllers for use with Windows, including those for
  which you have a device support disk from a mass storage device
  manufacturer, press S.

* If you do not have any device support disks from a mass storage
  device manufacturer, or do not want to specify additional
  mass storage devices for use with Windows, press ENTER.

Windows Setup

Press F6 if you need to install a third party SCSI or RAID driver...
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4. Insert the RAID driver disk you created earlier to the floppy disk drive, then 
press <Enter>.

Windows Setup

ENTER=Continue   ESC=Cancel   F3=Exit

Please insert the disk labeled

Manufacturer-supplied hardware support disk

into Drive A:

*  Press ENTER when ready.

5. Select LSI MegaRAID SAS RAID Controller Driver complying with your 
Windows® OS version, and then press <Enter>.

Windows Setup

ENTER=Select   F3=Exit

You have chosen to configure a SCSI Adapter for use with Windows,
using a device support disk provided by an adapter manufacturer.

Select the SCSI Adapter you want from the following list, or press ESC
to return to the previous screen.

LSI MegaRAID SAS RAID Controller Driver (Windows 2003) 
LSI MegaRAID SAS RAID Controller Driver (Server 2003 32-bit)

6. The Windows® Setup loads the RAID card drivers from the RAID driver disk. 
When next screen appears, press <Enter> to continue installation.

7. Setup then proceeds with the OS installation. Follow screen instructions to 
continue.
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After Windows® OS installation
To update the RAID card driver after installing Windows® OS:

1. Right-click the My Computer icon on the desktop and select Properties from 
the menu.

2. Click the Hardware tab on the top, then click the Device Manager button.
3. Double-click the LSI Logic MegaRAID SAS PCI Express ROMB item.

4. Click the Driver tab on the top, then click Update Driver.
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5. Toggle Install from a list or specific location (Advanced), then click Next 
to continue.

6. Toggle Don’t search. I will choose the driver to install, then click Next to 
continue.

7. Insert the RAID driver disk you created earlier to the floppy disk drive.
8. Highlight LSI Logic MegaRAID SAS PCI Express ROMB, then click Have 

Disk.
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9. Select from the drop-down menu and locate the driver.

10. Click Next to start updating the driver.

11. After completing driver update, click Finish to close the wizard.
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3.1.3 Red Hat® Enterprise Linux OS
To install the RAID card driver when installing Red Hat Red Hat® Enterprise OS:

1. Boot the system from the Red Hat® OS installation CD.
2. At the boot:, type linux dd, then press <Enter>.

-  To install or upgrade in graphical mode, press the <ENTER> key.
-  To install or upgrade in text mode, type: linux text <ENTER>.
-  Use the function keys listed below for more information.
[F1-Main] [F2-Options] [F3-General] [F4-Kernel] [F5-Rescue]
boot: linux dd

4. Select fd0 using the <Tab> key when asked to select the driver disk source. 
Press <Tab> to move the cursor to OK, then press <Enter>.

3. Select Yes using the <Tab> key when asked if you have the driver disk, then 
press <Enter>.

Main Menu

Do you have a driver disk?

Yes No

Driver Disk Source

You have multiple devices which could 
serve as sources for a driver disk. 
Which would you like to use?

OK Cancel

fd0
scd0
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6. When asked if you will load additional RAID controller drivers, select No, then 
press <Enter>.

5. Insert the Red Hat® Enterprise RAID driver disk to the floppy disk drive, select 
OK, then press <Enter>.

 The drivers for the RAID card are installed to the system.

Insert Driver Disk

Insert your driver disk into /dev/fd0 
and press “OK” to continue.

OK Back

7. Follow the screen instructions to continue the OS installation.

More Driver Disks?

Do you wish to load any more 
driver disks?

Yes No
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3.1.4 SUSE Linux Enterprise Server OS
To install the RAID card driver when installing SUSE Linux Enterprise Server OS: SUSE Linux Enterprise Server OS:

1. Boot the system from the SUSE OS installation CD.
2. Use the arrow keys to select Installation from the Boot Options menu.

F1 Help  F2 Language  F3 1280 x 1024  F4 DVD  F5 Driver

Boot from Hard Disk
Installation
Installation--ACPI Disabled
Installation--Local APIC Disabled
Installation--Safe Settings
Rescue System
Memory Test

Boot Options |

3. Press <F5>, then select Yes from the menu. Press <Enter>.

F1 Help  F2 Language  F3 1280 x 1024  F4 DVD  F5 Driver

Boot from Hard Disk
Installation
Installation--ACPI Disabled
Installation--Local APIC Disabled
Installation--Safe Settings
Rescue System
Memory Test

Boot Options | Yes
No
File
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4. Insert the RAID driver disk to the floppy disk drive. Make sure that Installation 
from the Boot Options menu is selected, then press <Enter>.

F1 Help  F2 Language  F3 1280 x 1024  F4 DVD  F5 Driver

Boot from Hard Disk
Installation
Installation--ACPI Disabled
Installation--Local APIC Disabled
Installation--Safe Settings
Rescue System
Memory Test

Boot Options |

5. When below screen appears, select the floppy disk drive (fd0) as the driver 
update medium. Select OK, then press <Enter>.

Please choose the Driver Update medium.

OK Back

fd0: Floppy
sr0: CD-ROM, TEAC DV-516E
sda: Disk, SEAGATE ST336754SS
sdb: Disk, SEAGATE ST336754SS
Other device

 The drivers for the RAID controller are installed to the system.
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